Notes, Cautions, and Warnings

NOTE: A NOTE indicates important information that helps you make better use of your product.

CAUTION: A CAUTION indicates either potential damage to hardware or loss of data and tells you how to avoid the problem.

WARNING: A WARNING indicates a potential for property damage, personal injury, or death.
# Contents

## 1 Overview
- About this Document ................................................................. 5
- What’s New in this Release .......................................................... 5
- Accessing Online Help ................................................................. 5
- Other Documents You May Need .................................................. 6
  - Contacting Dell Technical Support ............................................. 6
- Licensing ..................................................................................... 6
- Important Note ............................................................................ 7
- ASM Port and Protocol Information ............................................. 7

## 2 Installation and Quick Start
- Information Pre-requisites .......................................................... 9
- Installing Active System Manager .............................................. 9
  - Deployment Pre-requisites ........................................................ 9
  - Pre-requisites for System Center Virtual Machine Manager (SCVMM) ............................................................................. 14
  - Deploying ASM on VMware vSphere ........................................ 14
  - Deploying ASM using SCVMM .................................................. 15
  - Deploying ASM on Hyper-V Host .............................................. 16
  - Deploying ASM Appliance as Kernel-Based Virtual Machine (KVM) .............................................................................. 16
- Downloading Catalog File ............................................................ 17
- Updating the ASM Appliance ....................................................... 17

## 3 Configuring ASM Virtual Appliance
- Changing Dell Administrator Password ....................................... 18
  - Accessing the Initial Appliance Configuration ............................ 18
  - Configuring Static IP Address in the Virtual Appliance ................ 18
  - Configuring Virtual Appliance with Two NICS ............................ 19
  - Configuring ASM Virtual Appliance as PXE Boot Responder .......... 19

## 4 Customizing Virtual Machine Templates for VMware and Hyper-V
- Customizing Virtual Machine Templates or Virtual Machines for VMware or Hyper-V ......................................................... 20
  - Customizing Linux Template ...................................................... 21
  - Customizing Windows Template ................................................ 23
  - Customizing the vCenter Windows Template ............................... 25

## 5 Enabling EMC VNX Support
- Installing Plug-ins for EMC to Support Volume Provisioning ........... 27

## 6 Completing Initial Configuration
- A Installing Windows ADK 8.1 for OS Prep for Windows ............... 28
    - Adding OS Image Repositories ................................................. 30
B Configuring DHCP or PXE on External Servers

Configure DHCP on Windows 2012 DHCP Server
Creating the DHCP User Class
Creating the DHCP Policy
Creating the Boot File Scope Option
Configuring DHCP on Windows 2008 DHCP Server
Configuring DHCP for Linux
Overview

Active System Manager (ASM) is Dell’s unified management product that provides a comprehensive infrastructure and workload automation solution for IT administrators and teams. ASM simplifies and automates the management of heterogeneous environments, enabling IT to respond more rapidly to dynamic business needs. IT organizations today are often burdened by complex data centers that contain a mix of technologies from different vendors and cumbersome operational tasks for delivering services while managing the underlying infrastructure. These tasks are typically performed through multiple management consoles for different physical and virtual resources, which can dramatically slow down service deployment. ASM features an enhanced user interface that provides an intuitive, end-to-end infrastructure and workload automation experience through a unified console. This speeds up workload delivery and streamlines infrastructure management, enabling IT organizations to accelerate service delivery and time to value for customers.

This document contains information about virtual appliance and software requirements of ASM, and the resources supported by ASM such as chassis, servers, storage, network switches, and adapters.

About this Document

This document version is updated for ASM release 8.3.1.

What’s New in this Release

Active System Manager 8.3.1 is focused on expanding capabilities around vSAN deployment, adding new capabilities around managing Ready Bundle for Virtualization, the industry’s most flexible converged system offering in a virtualized environment. For more information about the supported hardware components, see the ASM 8.3.1 Compatibility Matrix at dell.com/asmdocs.

The highlights of the Active System Manager Release 8.3.1 include the following:

• Support for the SATADOM boot option for Dell PowerEdge R630, PowerEdge R730, and PowerEdge R730xd systems.
• Support for the Dell Storage Center Operating system (SCOS) 7.1, which promotes greater flash adoption and increased data efficiency.
• Extended ASM plug-in support for vRealize Orchestrator 7.1.
• Support for virtual SAN (vSAN) 6.5, which offers improved scalability, flexibility, and automation capabilities.

This release also includes compatibility support for the following:

• Support of the vSAN configurations for the Ready Bundle for Virtualization
  – PowerEdge R630, PowerEdge R730, PowerEdge R730XD hybrid configurations.
  – PowerEdge FC430, PowerEdge FC630, and PowerEdge FX2 - all flash configurations.

Accessing Online Help

ASM online help system provides context-sensitive help available from every page in the ASM user interface.

Log in to the ASM user interface with the user name admin and then enter password admin, and press Enter.

After you log in to ASM user interface, you can access the online help in any of the following ways:
• To open context-sensitive online help for the active page, click ? , and then click Help.
• To open context-sensitive online help for a dialog box, click ? in the dialog box.

Also, in the online help, use the Enter search items option in the Table of Contents to search for a specific topic or keyword.

Other Documents You May Need

See http://www.dell.com/asmdocs for additional supporting documents such as:

• Active System Manager Release 8.3.1 User’s Guide
• Active System Manager Release 8.3.1 Release Notes
• Active System Manager Release 8.3.1 Compatibility Matrix
• Active System Manager Release 8.2 SDK Reference Guide
• Active System Manager Integration for VMware vRealize Orchestrator User’s Guide
• Active System Manager Release 8.3.1 API Reference Guide

Contacting Dell Technical Support

To contact Dell Technical Support, make sure that the Active System Manager Service Tag is available.

• Go to the tech direct portal https://techdirect.dell.com
• Log in using your existing account or create an account if you do not have an account.
• Create a case for your incident.
• Add your Active System Manager service tag.
• Select Active System Manager as the Incident type.
• Type the relevant information in the Problem Details, and add attachments or screen shots if necessary.
• Fill in contact information and submit the request.

Licensing

ASM licensing is based on the total number of managed resources, in an environment being managed by ASM.

Resources that make use of an ASM license contains:

• Physical servers
• Switches (access layer with server facing switch ports, or having their Firmware updated by ASM)
• Storage array controllers

Resources that do not make use of an ASM license contains:

• Chassis Management Controllers
• Switches (Core switches without server facing switch ports, or not having their Firmware updated by ASM)
• Virtual Machines
• Virtual Machine Managers (For example, vSphere, System Center Virtual Machine Manager)
• Switch ports
• CPU cores

ASM 8.3.1 supports following license types:

• Trial License—A trial license can be procured through the account team and it supports up to 25 resources for 120 days.
Standard License—A standard license grants full access.

After purchasing ASM, an email is sent from customer service containing instructions for downloading ASM software components, the ASM license file, and the ASM Service Tag.

If you are using ASM for the first time, you must upload the license file using the Initial Setup wizard. To upload and activate subsequent licenses, click Settings → Virtual Appliance Management.

1. Under the License Management section, on the Virtual Appliance Management page, click Add. The Add License window is displayed.
2. Click Choose File beside Upload License and select an evaluation license file, and then click Open.
   The License Management window with the license type, number of resources, and expiration date of the uploaded license is displayed.
3. Click Save to apply the Trial license.
4. After uploading the license file, the following information about the license is displayed:
   - License Type
   - Number of Resources
   - Number of Used Resources
   - Number of Available Resources
   - Expiration Date
5. To replace the evaluation license with standard license, click Add under License Management section, click Choose File beside Upload License and select a regular standard license file, and then click Open.
   You get information regarding license type, number of resources and expiration date of the uploaded license on the License Management window.
6. Click Save to apply the standard license.
   It replaces the evaluation license with standard license.

You can add multiple standard licenses. After uploading multiple licenses, all the licenses are aggregated together and displayed as one under the License Management section.

⚠️ NOTE: If you try to upload the same standard license second time, you get an error message stating that License has already been used.

**Important Note**

Engaging support requires that all pre-requisites are fulfilled by customer or deployment team. Third-party hardware support is not provided by Dell services. Discovery, inventory, and usage of third-party hardware must be in the expected state as described in the pre-requisites and configuring sections of this guide.

**ASM Port and Protocol Information**

The following ports and communication protocols are used by ASM to transfer and receive data.

<table>
<thead>
<tr>
<th>Ports</th>
<th>Protocols</th>
<th>Port Type</th>
<th>Direction</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>22</td>
<td>SSH</td>
<td>TCP</td>
<td>Inbound/Outbound</td>
<td>I/O Module</td>
</tr>
<tr>
<td>23</td>
<td>Telnet</td>
<td>TCP</td>
<td>Outbound</td>
<td>I/O Module</td>
</tr>
<tr>
<td>53</td>
<td>DNS</td>
<td>TCP</td>
<td>Outbound</td>
<td>DNS Server</td>
</tr>
<tr>
<td>67, 68</td>
<td>DHCP</td>
<td>UDP</td>
<td>Outbound</td>
<td>DHCP Server</td>
</tr>
<tr>
<td>Ports</td>
<td>Protocols</td>
<td>Port Type</td>
<td>Direction</td>
<td>Use</td>
</tr>
<tr>
<td>---------</td>
<td>-----------</td>
<td>-----------</td>
<td>-----------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>69</td>
<td>TFTP</td>
<td>UDP</td>
<td>Inbound</td>
<td>Firmware Updates</td>
</tr>
<tr>
<td>80, 8080</td>
<td>HTTP</td>
<td>TCP</td>
<td>Inbound /Outbound</td>
<td>HTTP Communication</td>
</tr>
<tr>
<td>123</td>
<td>NTP</td>
<td>UDP</td>
<td>Outbound</td>
<td>Time Synchronization</td>
</tr>
<tr>
<td>162, 11620</td>
<td>SNMP</td>
<td>UDP</td>
<td>Inbound</td>
<td>SNMP Synchronization</td>
</tr>
<tr>
<td>443</td>
<td>HTTPS</td>
<td>TCP</td>
<td>Inbound /Outbound</td>
<td>Secure HTTP Communication</td>
</tr>
<tr>
<td>443, 4433</td>
<td>WS-MAN</td>
<td>TCP</td>
<td>Outbound</td>
<td>iDRAC and CMC Communication</td>
</tr>
<tr>
<td>129, 445</td>
<td>CIFS</td>
<td>TCP</td>
<td>Inbound /Outbound</td>
<td>Back up program date to CIFS share</td>
</tr>
<tr>
<td>2049</td>
<td>NFS</td>
<td>TCP</td>
<td>Inbound /Outbound</td>
<td>Back up program data to NIFS share</td>
</tr>
</tbody>
</table>
Installation and Quick Start

The following sections provide installation and quick start information, including step-by-step instructions for deploying and configuring ASM in VMware vSphere or Microsoft virtualization environment. Only one instance of ASM should be installed within a network environment. Exceeding this limit can cause conflicts in device communication.

Information Pre-requisites

Before you begin the installation process:

- Gather the TCP/IP address information to assign to the virtual appliance.
- Ensure that the VMware vCenter Server and VMware vSphere Client are running, if you are deploying the ASM virtual appliance in a VMware vSphere environment.
- Deploying the ASM virtual appliance to a Microsoft Windows virtualization environment requires that the Hyper-V host on which ASM is deployed is installed on a running instance of SCVMM.
- Download ASM Appliance file, which contains either the virtual appliance.ova file for (VMware) or the virtual appliance virtual hard drive .vhd (Hyper-V) or the qcow2 file for KVM installation.
- Determine the host on which the ASM virtual appliance is installed. You can use any host managed by VMware vCenter or the Hyper-V manager or KVM that has network connectivity with your out-of-band (OOB), management, and potentially iSCSI networks. This is required for discovery to complete successfully.
- It is recommended to deploy the ASM virtual appliance with minimum four virtual CPUs (vCPUs) and 16 GB memory or RAM.

⚠️ CAUTION: ASM virtual appliance functions as a regular virtual machine. Therefore, any interruptions or shutdown affects the overall functionality.

Installing Active System Manager

Before you begin, ensure that systems are connected and VMware vCenter Server, VMware vSphere Client, KVM, and SCVMM are running.

⚠️ NOTE: All switches must have SSH connectivity enabled.

Deployment Pre-requisites

<table>
<thead>
<tr>
<th>Specification</th>
<th>Pre-requisite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Requirements</td>
<td>- The virtual appliance is able to communicate with the out-of-band management network and any other networks from which you want to discover the resources.</td>
</tr>
<tr>
<td></td>
<td>- The virtual appliance is able to communicate with the OS Installation network in which the Appliance is deployed. It is recommended to configure the virtual appliance directly on the OS Installation network, and not on the external network.</td>
</tr>
</tbody>
</table>

For more information about OS Installation network, see the "Network Types" section in Active System Manager Release 8.3.1 User’s Guide.
<table>
<thead>
<tr>
<th>Specification</th>
<th>Pre-requisite</th>
</tr>
</thead>
<tbody>
<tr>
<td>• The virtual appliance is able to communicate with the hypervisor management network.</td>
<td>• The DHCP server is fully functional with appropriate PXE settings to PXE boot images from ASM in your deployment network. For more information, see the &quot;Configuring DHCP or PXE on External Servers&quot; section in this guide.</td>
</tr>
<tr>
<td>• When deploying the ASM Appliance, ensure that the Default Gateway is specified. For DHCP network configuration, the Default Gateway must be specified in the DHCP scope. For static network configuration, ensure that at least one network interface is configured with a gateway.</td>
<td></td>
</tr>
<tr>
<td>vCenter</td>
<td>Ensure that the Virtual SAN Default Storage Policy is set to the following default values:</td>
</tr>
<tr>
<td></td>
<td>• Number of failures to tolerate: 0</td>
</tr>
<tr>
<td></td>
<td>• Number of disks stripes per disk: 1</td>
</tr>
<tr>
<td></td>
<td>• Force Provisioning: No</td>
</tr>
<tr>
<td></td>
<td>• Object space reservation: 0%</td>
</tr>
<tr>
<td></td>
<td>• Flash read cache reservation: 0.000%</td>
</tr>
<tr>
<td></td>
<td>☑️ NOTE: To view or update the Storage policy, on the VMware vSphere Web Client, click Home → Policies and Profiles → VM Storage Policies → Virtual SAN Default Storage Policy.</td>
</tr>
<tr>
<td>Brocade for Dell Compellent</td>
<td>Alias needs to be created having Dell Compellent fault domain WWPN accessible on the Brocade switch. Create a single alias including the virtual ports for the Dell Compellent fault domain, WWPN accessible on the Brocade switch. ASM automates the creation of each additional zone for the server objects and place them into a zone config.</td>
</tr>
<tr>
<td></td>
<td>☑️ NOTE: Ensure that the single alias is listed first in the list of aliases.</td>
</tr>
<tr>
<td>Brocade for EMC VNX</td>
<td>Alias needs to be created having EMC VNX WWPN accessible on the Brocade switch. Create a single alias in the Brocade switches including WWPN accessible on the Brocade switch. ASM automates the creation of each additional zone for the server objects and place them into a zone config.</td>
</tr>
<tr>
<td>Dell PowerEdge servers</td>
<td>• Dell PowerEdge servers are configured and have the management IP address and login credentials assigned.</td>
</tr>
<tr>
<td></td>
<td>☑️ NOTE: The user name (root) and password required.</td>
</tr>
<tr>
<td></td>
<td>• Any device being used in the boot order, such as C: Drive or NICs, must already be enabled in the boot order. This applies when booting to SD card, Hard Disk, or Fibre Channel which are listed as C: in boot order or PXE and iSCSI, which are listed as NICs in the boot order. ASM enables the supporting device connectivity and adjusts the boot order, but cannot enable or disable device names in the boot order.</td>
</tr>
<tr>
<td></td>
<td>• Before performing Fibre Channel boot from SAN, a server must be configured with the QLogic Fibre Channel card, which is configured with the appropriate scan selection. To verify this in the BIOS and QLogic device settings, press F2 for System Set up, and then go to Device Settings → &lt;Target QLogic Fibre Channel adapter name&gt; → Fibre Channel Target Configuration → Boot Scan, and then select First LUN. The First LUN setting needs to be disabled for deployments other than Boot from SAN.</td>
</tr>
<tr>
<td></td>
<td>☑️ NOTE: For all servers prior to ASM discovery, ensure that the RAID controller is enabled.</td>
</tr>
<tr>
<td></td>
<td>After updating these devices settings, you should restart the server to ensure that the Lifecycle Controller system inventory is updated.</td>
</tr>
<tr>
<td></td>
<td>• Ensure that the Non-RAID Disk Mode option is selected in the system BIOS to configure non-RAID disks.</td>
</tr>
<tr>
<td></td>
<td>☑️ NOTE: You can also set the non-RAID mode, by setting the RAID controller to the default settings.</td>
</tr>
<tr>
<td>Specification</td>
<td>Pre-requisite</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cisco servers</td>
<td>• Network and BIOS configuration cannot be complete using Appliance. You must do it manually.</td>
</tr>
<tr>
<td>Dell Force10 S4810 switches—</td>
<td>• The management IP address is configured for the ToR switches.</td>
</tr>
<tr>
<td>Top-of-Rack [ToR]</td>
<td>• Any VLAN which is dynamically provisioned by ASM must exist on the ToR switch.</td>
</tr>
<tr>
<td></td>
<td>• Server facing ports must be configured for spanning tree portfast.</td>
</tr>
<tr>
<td></td>
<td>• If DCB settings are used, it must be properly configured on the switch for converged traffic.</td>
</tr>
<tr>
<td></td>
<td>• Switches have SSH connectivity enabled.</td>
</tr>
<tr>
<td></td>
<td>• Ensure that lacp ungroup is not set to vlt on your switches.</td>
</tr>
<tr>
<td>N-Series Switches</td>
<td>• The management IP address is configured for the switches.</td>
</tr>
<tr>
<td></td>
<td>• ASM creates the virtual machine (VM) traffic VLANs dynamically.</td>
</tr>
<tr>
<td></td>
<td>• You have access to the switches with passwords enabled.</td>
</tr>
<tr>
<td></td>
<td>• Switches have SSH connectivity enabled.</td>
</tr>
<tr>
<td></td>
<td>• Server facing ports must be in hybrid mode.</td>
</tr>
<tr>
<td></td>
<td>• Server facing ports must be in switch port mode.</td>
</tr>
<tr>
<td></td>
<td>• Server facing ports must be configured for spanning tree portfast.</td>
</tr>
<tr>
<td></td>
<td>• If DCB settings are used, it must be properly configured on the switch for converged traffic.</td>
</tr>
<tr>
<td>Dell PowerEdge M I/O Aggregator</td>
<td>If ASM is used to perform the initial configuration of credentials and IPs on the IOM in the Blade chassis, you must to ensure, no enabled password is configured on the switches.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> ASM supports only stand-alone and PMUX mode.</td>
</tr>
<tr>
<td>Dell Networking MXL 10/40GbE Blade switch</td>
<td>• Any VLAN which is dynamically provisioned by ASM must exist on the switch.</td>
</tr>
<tr>
<td></td>
<td>• Ensure that DCB settings are configured on each port.</td>
</tr>
<tr>
<td></td>
<td>• If ASM is used to perform the initial configuration of credentials and IPs on the IOM in the Blade chassis, you must ensure, no enabled password is configured on the switches.</td>
</tr>
<tr>
<td></td>
<td>• Switches have SSH connectivity enabled.</td>
</tr>
<tr>
<td>Dell 8</td>
<td>4 I/O modules</td>
</tr>
<tr>
<td>EqualLogic Storage Array</td>
<td>• The management and group IP addresses are configured for Storage Array.</td>
</tr>
<tr>
<td></td>
<td>• All storage array members are added to the group.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The EqualLogic management interface must be configured to enable dedicated management network.</td>
</tr>
<tr>
<td></td>
<td>• EqualLogic array must have an SNMP community name set to &quot;public&quot;.</td>
</tr>
<tr>
<td>Dell Compellent Storage Array</td>
<td>• The management IP address is configured for the Storage Array.</td>
</tr>
<tr>
<td></td>
<td>• All Storage array members are added to the group.</td>
</tr>
<tr>
<td></td>
<td>• Virtual ports must be enabled on Dell Compellent.</td>
</tr>
<tr>
<td></td>
<td>• Follow Dell Compellent best-practices for Storage configuration.</td>
</tr>
<tr>
<td></td>
<td>• Storage Centers needs to be added to the Enterprise Manager before initiating the Element Manager discovery in ASM.</td>
</tr>
<tr>
<td></td>
<td>• Fault Domain and IP address configuration of the iSCSI controllers needs to be complete before discovery Element Manager in ASM.</td>
</tr>
<tr>
<td></td>
<td>• Discovery of EM needs to be complete with same credentials which are used for add Storage Center in Element Manager.</td>
</tr>
<tr>
<td></td>
<td>• Enable SNMP on Dell Compellent to enable ASM to monitor the device.</td>
</tr>
</tbody>
</table>
For more information about creating alias, see Brocade for the Dell Compellent Compellent section in this topic.

- Before initiating ASM service to create a volume on a newly configured Dell Compellent Storage array, create a temporary volume. A Storage type is instantiated on the Compellent Storage array, and used in creating a volume by ASM.

- Enable LLDP and its corresponding attributes.

- DCB (with no PFC option) on the participating interfaces—Server Facing and Port-Channel Members. Since DCB is globally enabled, the PFC should be turned off individually in those interfaces.

- Link Level Flow control (LLFC) must be Rx ON and Tx OFF on the respective interfaces.

- MTU must be set to 9216 on respective interfaces.

### Sample server facing interface configuration

FTOSA1#show running-config interface tengigabitethernet 0/15

```bash
! interface TenGigabitEthernet 0/15
no ip address
mtu 9216
portmode hybrid
switchport
flowcontrol rx on tx off
spanning-tree 0 portfast
spanning-tree pvst edge-port
dcb-map DCB_MAP_PFC_OFF
!
protocol lldp
advertise management-tlv management-address system-name
dcbx port-role auto-downstream
no shutdown
```

### Sample port-channel member interface configuration

FTOSA1#show running-config interface tengigabitethernet 0/41

```bash
! interface TenGigabitEthernet 0/41
no ip address
mtu 9216
dcb-map DCB_MAP_PFC_OFF
```
**Specification** | **Pre-requisite**
--- | ---
! | port-channel-protocol LACP  
port-channel 1 mode active  
! | protocol lldp  
advertise management-tlv management-address system-name  
no advertise dcbbx-tlv ets-reco  
dcbx port-role auto-upstream  
no shutdown  
FTOSA1#
VMware vCenter 5.1, 5.5, 6.0, or 6.5 | • VMware vCenter 5.1, 5.5, 6.0, or 6.5 is configured and accessible through the management and hypervisor management network.  
• Appropriate licenses are deployed on the VMware vCenter.
System Center Virtual Machine Manager (SCVMM) | • See [System Center Virtual Machine Manager (SCVMM) Prerequisites](#).  
• If SCVMM is managing servers from other domains or sub domains, those domain names need to be added to the DNS tab of the Advanced TCP/IP settings in network configuration on the SCVMM server. Add each domain and sub domain to the box under Append these DNS suffixes—in order.
OS Installation | • Either use Active System Manager as the PXE responder by configuring through ASM user interface, by the [Getting Started](#) page or follow instructions in Configuring ASM virtual appliance as PXE Responder.
Dell PowerEdge M1000e chassis | **NOTE:** Prior to deployment of M1000e server, you must disable FlexAddress on every server in the chassis.  
To disable FlexAddress, follow the path: [CMC > Server Overview > Setup > FlexAddress](#).  
You must turn off the server to disable FlexAddress. This should be complete prior discovering the server.  
This setting applies to the chassis and the servers in the chassis, not to the IOM switches such as MXL or IOA.
Dell PowerEdge FX2 chassis | **NOTE:** Prior to deployment of FX2 server, you must disable FlexAddress on every server in the chassis.  
To disable FlexAddress, follow the path: [CMC > Server Overview > Setup > FlexAddress](#).  
You need to turn off the server to disable FlexAddress. This should be complete prior to discovering the server.  
This setting applies to the chassis and the servers in the chassis, not to the IOM switches such as MXL or IOA.
EMC Storage | • VNX alias must be created in the Brocade switches.  
For more information about creating alias, see [Brocade for EMC VNX](#) section in this topic.  
**NOTE:** You can select the Thin LUN option only if you have appropriate licenses deployed on the EMC storage device.
Pre-requisites for System Center Virtual Machine Manager (SCVMM)

ASM manages resource on Microsoft System Center Virtual Machine Manager through Windows Remote Management (WinRM). Windows RM must be enabled on the SCVMM server and on Active Directory and DNS servers used in SCVMM/HyperV deployments. ASM deployments support Active Directory and DNS servers which exist on the same machine. If Active Directory and DNS servers exist on separate machines, some manual tear down may be required to remove host entries from the DNS server. ASM requires WinRM to utilize default port and basic authentication. To enable WinRM settings, on the SCVMM server and on the Active Directory and DNS server used in Hyper-V deployments, open a Windows PowerShell interface with administrator permissions and run the following commands:

```powershell
Write-Host "Configuring HTTPS WinRM"
$DomainFullyQualifiedName = $env:DomainFullyQualifiedName
$DNSName = "$env:computername.$env:DomainFullyQualifiedName"
Write-Host "Fully Qualified Domain Name: $DNSName"
$cert = New-SelfSignedCertificate -DnsName $DNSName -CertStoreLocation Cert:\LocalMachine\My
Write-Host "Certificate Info: $cert"
$thumbprint = $cert.thumbprint
$cmd = "winrm create winrm/config/Listener?Address=*+Transport=HTTPS @{Hostname="$DNSName";CertificateThumbprint="$thumbprint"}"
$cmd /c $cmd
winrm quickconfig -transport:https
```

In case port 5986 that is required for WinRM HTTPS is blocked by the Active Directory policy, run the following command to update the firewall rule:

```powershell
New-NetFirewallRule -DisplayName "WinRM HTTPS" -Action Allow -AsJob -Enabled True -LocalPort 5986 -Protocol TCP -Direction InBound
```

The default amount of memory allocated for WinRM processes is limited to 150 MB. To avoid out of memory errors, increase the memory size to 1024:

```powershell
winrm set winrm/config/winrs '@{MaxMemoryPerShellMB="1024"}'
```

For Windows 2008:

```powershell
winrm quickconfig
```

---

**NOTE:** There is a known issue with WMF 3.0. The MaxMemoryPerShellMB configuration may be ignored. For more information, see the Microsoft knowledge base article KB2842230. The fix for Windows 8/Windows 2012 x64 (non R2) is available at the following link. The fix is not necessary for Windows 2012 R2.

Make sure that the SCVMM time is synchronized with the time of the associated timer server. If the SCVMM timer is set to 'off' mode by using the deployed Hyper-V hosts, you cannot add hosts and create clusters in SCVMM.

---

**NOTE:** If SCVMM is managing servers from other domains or sub domains, ensure that those domain names are added under Advanced TCP/IP Settings → DNS → Append these DNS suffixes (in order) section. You can access the Advanced TCP/IP settings in the network configuration on the SCVMM server.

Deploying ASM on VMware vSphere

1. Extract the .zip file to a location accessible by VMware vSphere Client. It is recommended to use a local drive or CD/DVD, because installing from a network location can take up to 30 minutes.
2. In vSphere Client, select File → Deploy OVF Template. The Deploy OVF Template wizard is displayed.
3. On the Source page, click Browse, and then select the OVF package. Click Next to continue.
4. On the OVF Template Details page, review the information that is displayed. Click Next to continue.
5. On the End User License Agreement page, read the license agreement and click Accept. To continue, click Next.
6. On the Name and Location page, enter a name with up to 80 characters and then, select an Inventory Location where the template is stored. Click Next to continue.
7. Depending on the vCenter configuration, one of the following options are displayed:
• If resource pools are configured—On the Resource Pool page, select the pool of virtual servers to deploy the Appliance virtual machine.

• If resource pools are NOT configured—On the Hosts/Clusters page, select the host or cluster on which you want to deploy the Appliance virtual machine.

Click Next to continue.

8. If there is more than one datastore available on the host, the Datastore page displays. Select the location to store virtual machine (VM) files, and then click Next to continue.

9. On the Disk Format page, choose one of the following options:
   - To allocate storage space to virtual machines as required, click thin provisioned format.
   - To preallocate physical storage space to virtual machines at the time a disk is created, click thick provisioned format.

Click Next to continue.

10. On the Ready to the Complete page, review the options you selected on previous pages and click Finish to run the deployment job. A completion status window displays where you can track job progress.

   NOTE: When deploying Virtual Machines to an existing vCenter cluster using an ASM template, ensure that all OS Installation or Public or Private LAN networks (which are used on the Virtual Machine) are defined as Networks in ASM. The name parameter of the Networks in ASM should match with the name of the port groups on the ESXi hosts.

### Deploying ASM using SCVMM

To deploy ASM using SCVMM:

1. Extract the .zip file for ASM build to a local folder on your SCVMM appliance `<ASM_INSTALLER_ROOT_DIR>`.

2. To add ASM to the Library of Physical Library Objects in SCVMM, do the following:
   - In the left pane, click Library.
   - In the Home tab, click Import Physical Resource.
   - Click the Add Resource button. Browse to the location of ASM .vhd file: `<ASM_INSTALLER_ROOT_DIR>\Virtual Hard Disks\Dell-ActiveSystemManager-8.3.1-<build>.vhd`
   - Under the Select library server and destination for imported resources section, click Browse. Select the destination folder in which ASM install VHD is located (for example, My_SCVMM -> MSCVMMLibrary -> VHDs), and then click OK.
   - Click Import.

3. To deploy ASM virtual appliance:
   - In the left pane, click VMs and Services.
   - Click Create Virtual Machine.
   - Select Use an existing virtual machine, VM template, or virtual hard disk, and then click the Browse.
   - From the list of sources, select VHD -> Dell-ActiveSystemManager-8.3.1-<build>.vhd, and then click OK.
   - Click Next.
   - In the Virtual machine name text box, type the virtual machine name for your Appliance, and then click Next.
   - On the Configure Hardware page, do the following:
     1. In the Compatibility section, set Cloud Capability Profile to Hyper-V.
     2. In the Processors section, change the processor value to 4, and then in the Memory section, change the memory value to 16 GB.

   NOTE: The number of "big" processes that can be executed in parallel by default is set to the number of processors assigned to a VM. For example, if you give your Appliance 8 processors, it executes eight processes at once instead of the default 4 processes.
3. In the **Network Adapter 1** section, assign the adapter to your PXE VM Network.

4. Click **Next**.

   h. On the **Select Destination** page, select the destination host group that contains the Hyper-V server where you want to deploy ASM VM. Click **Next**.

   i. On the **Select Host** page, select the host on which you want to deploy ASM, and then click **Next**.

   j. On the **Configuration Settings** page, make the changes for your environment, if necessary.

   k. On the **Select networks** page, select your OS Installation network and configure it appropriately.

   l. On the **Add Properties** page, set to **Always turn on the Virtual Machine** and the OS as **CentOS Linux (64 bit)**, and then click **Next**.

   m. Review the summary, select the **Start Virtual machine after deploying it** option, and then click **Create**.

---

**Deploying ASM on Hyper-V Host**

To deploy ASM on the Hyper-V host:

1. Open Hyper-V Manager in the Windows 2012 host. The Windows 2012 host should be displayed under Hyper-V Manager.

2. Select the host, and select **Action → Import Virtual Machine**.

3. Select the folder containing ASM virtual appliance including snapshots, virtual hard disks, virtual machines, and import files. Click **Next**.

4. On the **Select Virtual Machine** page, select the virtual machine to import (there is only one option available), and then click **Next**.

5. On the **Choose Import Type** page, select **Copy the virtual machine**, and then click **Next**.

6. On the **Choose Destination** page, retain the default values, or select the location of the virtual machine, snapshot, and smart paging, and click **Next**.

7. On the **Choose Storage Folders** page, retain the default values or click **Browse** and select the location of virtual hard disks, and then click **Next**.

8. On the **Summary** page, review the options you selected on earlier pages, and then click **Finish** to deploy ASM virtual appliance on the Hyper-V host.

9. After ASM virtual appliance is deployed, right-click ASM virtual appliance, and then click **Settings**.

10. In the **Settings** wizard, to enable the virtual switch, select **VM-Bus Network Adapter**. Optionally, provide a VLAN ID, if the host is tagged on a particular network, and then click **OK**.

11. Select ASM virtual appliance, and then click **Start under Actions**.

---

**Deploying ASM Appliance as Kernel-Based Virtual Machine (KVM)**

Before you begin deploying the ASM appliance as KVM, ensure that you have the following minimum connection requirements for the hypervisor:

- An Ethernet interface that uses a static IP to connect to the operating system.
- An Ethernet interface that is bound to the bridge device.

1. Extract the .zip file and copy the qcow2 file to **/var/lib/libvirt/images/** on your Linux KVM hypervisor.

2. Run the following command:

```bash
cert-install -n [vm name]--ram [size]--connect qemu:///system --network bridge=[name of network bridge interface]--os-type linux --os-variant rhel6 --disk /dev/sda,path=/var/lib/libvirt/images/[qcow2 file name],device=disk,format=qcow2,bus=scsi --vcpus [number of vcpus]--noautoconsole--import --graphics vnc, listen=0.0.0.0
```

3. To view the port the VNC console session is listening on, run the following command:

```bash
virsh vncdisplay [vm name]
```

For more information about accessing the Appliance console using a VNC application, see **Configuring ASM Virtual Appliance**.

---

**NOTE:** To destroy the virtual machine, run the following command:
virsh destroy [vm name]

\[NOTE: To remove the virtual machine from the list, run the following command:\]

virsh undefine [vm name]

**Downloading Catalog File**

To download the catalog file:

1. Go to Dell.com/asmdocs.
2. Click the latest version of the document, and then click Drivers & downloads → Systems Management.
3. Download the `<Filename>.zip` file and extract file (ASMCatalog.xml) to a network (NFS or CIFS) share.
4. In ASM, click Settings → Repositories → Firmware/Software Repositories → Add.
5. Select the Load repository and bundles from local network path option, provide the path to ASMCatalog.xml on the share, and the credentials if applicable.

**Updating the ASM Appliance**

To update the ASM Appliance:

1. Go to Dell.com/asmdocs.
2. Click the latest version of the document, and then click Drivers & downloads → Systems Management.
3. Download the `<Filename>.zip` file, and extract file to a network (NFS or CIFS) share.
4. In ASM, click Settings → Virtual Appliance Management.
5. On the Virtual Appliance Management page, edit the Update Repository Path and change the repository path to your http location of the folder that contains RepoConfig.xml, and then click Save.
6. To execute the update from the new http update share, click Update Virtual Appliance.
Configuring ASM Virtual Appliance

You must configure the following settings in the virtual appliance console before you start using ASM:

- Change Dell administrator password. For more information, see Changing Delladmin Password
- Configure static IP Address in the virtual appliance. For more information, see Configuring Static IP Address in the Virtual Appliance
- Configure ASM Virtual Appliance as PXE boot responder. For more information, see Configuring ASM Virtual Appliance as PXE Boot Responder
- Import Windows ISO on the virtual appliance. For more information, see Deploying WinPE on the Virtual Appliance
- Deploy the WinPE image file to the virtual appliance. For more information, see Deploying WinPE on the Virtual Appliance

Changing Dell Administrator Password

To change the Dell administrator default password:

1. In VMware Sphere, click the Console tab to open the console of the virtual appliance.
2. Log in to the console with the default user name delladmin and password delladmin and press Enter.
3. Click I Agree for EULA.
4. On the Initial Appliance Configuration user interface, click Change Admin Password.
5. Enter the Current Password, New Password, Confirm New Password, and click Change Password.

Accessing the Initial Appliance Configuration

To access the Initial Appliance Configuration after the first run:

1. In VMware Sphere, click the Console tab to open the console of the virtual appliance or use the SSH protocol to connect to ASM virtual appliance IP—ssh needs to be enabled on the appliance.
2. Log in to the console with the default user name delladmin and password and press Enter.
3. Enter the command asm_init_shell at the command prompt.

NOTE: If you use the ASM 8.3.1 user interface, to log in you must use the user name as admin with the default password as admin.

Configuring Static IP Address in the Virtual Appliance

1. In VMware Sphere, click the Console tab to open the console of the virtual appliance or use the SSH protocol to connect to ASM virtual appliance IP (ssh needs to be enabled on the appliance).
2. Log in to the console with the user name delladmin, enter current password, and then press Enter.

NOTE: The default password for delladmin account is delladmin.

3. At the command line interface, run the command asm_init_shell.
4. In the Appliance Configuration dialog box, click Network Configuration.
5. In the Network Connections dialog box, click Wired → Auto eth0, and then click Edit.
6. In the Editing Auto eth0 dialog box, click IPv4 Settings tab.
Configuring Virtual Appliance with Two NICS

If the OS Installation network is not routed, you must add an extra vNIC to the ASM appliance to make it communicate and respond to TFTP requests on the OS Installation network.

1. In VMware vSphere, select the Virtual Appliance and select “Power Off”.
2. Select Virtual Appliance and select “Edit Settings”.
3. Select “Add” in the properties page and choose “Ethernet Adapter”. Select Adapter Type as “VMXNET3”.
4. Select the PXE port group name that needs to be associated with the new network.
5. Select “Next” and then “OK” to ensure that the settings are updated on the Virtual Appliance.
6. Assign static IP address on the new network using the steps provided in section “Configuring Static IP Address in the Virtual Appliance”.

Configuring ASM Virtual Appliance as PXE Boot Responder

ASM may be configured to act as the DHCP server and PXE responder on an OS Installation network if one is not present in the environment. This can be configured through the Getting Started menu for appliance setup in the ASM user interface. If an external DHCP or PXE server is used for the OS Installation network, follow the instructions in the section Configuring DHCP or PXE on External Servers.

NOTE: Ensure that your DHCP scope has enough IP addresses. The installation process can temporarily consume between 4-8 IPs during the initial PXE boot process. This is based on interface card configuration and the number of physical interfaces on the server. These IPs only used temporarily during server configuration and installation.
Customizing Virtual Machine Templates for VMware and Hyper-V

ASM supports cloning virtual machines (VM) or virtual machine templates in VMware, and cloning virtual machine templates in Hyper-V and in Red Hat Enterprise Linux. For ASM virtual machine or virtual machine template cloning, the virtual machine or virtual machine templates must be customized to make sure that virtual machine or virtual machine templates have a unique identifier and can communicate back to the ASM Appliance upon completion of the cloning process. This requires several customizing steps that depend on virtual machine which is needed to be cloned.

**NOTE:** When cloning the VM, ensure that the original name used while creating or cloning the VM is retained.

Customizing Virtual Machine Templates or Virtual Machines for VMware or Hyper-V

ASM can clone existing virtual machines and virtual machine templates in vCenter, or virtual machine templates in Hyper-V. The source virtual machines and virtual machine templates must be customized according to the instructions provided in this section. After customization, you must shut down the virtual machine and you cannot restart the virtual machine. For VMware virtual machines or virtual machine templates, cloning is supported as long as you are cloning within the same data center. For SCVMM the virtual machine templates must exist in the SCVMM library. Cloning virtual machines directly is not currently supported for Hyper-V.

**NOTE:** Before cloning VMware and Hyper-V VMs, ensure that the virtual machine used for cloning is defined with a DHCP configuration in the operating system.

**NOTE:** After customization, if you restart the virtual machines, the virtual machine will no longer be valid for cloning, and in that case, the verification file must be deleted. See later in this section about deleting the verification file.

The following customization is required only for VMware virtual machines:

**Install VMware Tools on the virtual machine:**

- If the virtual machine being used does not have a DVD drive, you must add one. To do this, edit the settings of the virtual machine and add a DVD drive through your VMware management console.
- Once a DVD drive is available, right-click the virtual machine and select Guest → Install/Upgrade VMware Tools. This mounts the media for VMware tools.
- Log in to the operating system of the virtual machine and run the VMware tools installer within the OS running on the virtual machine. For more information on installing VMware tools, see VMware documentation.

The following customization is required for both VMware and Hyper-V virtual machine.

**Install the puppet agent on the virtual machine:**

- If the virtual machine being used was successfully created by ASM, the puppet agent will already be installed.
- To install the puppet agent on the virtual machine, copy the puppet agent install files to the virtual machine. The puppet agent is available on the ASM appliance for both Windows and Linux.

    in /var/lib/razor/repo-store directory. If the virtual machine being customized has network access to the ASM appliance, you can connect to this same directory as a network share directory using the address: $<ASM appliance hostname or IP>$/razor\puppet-agent.
Depending on your operating system, the installer may require extra packages (.rpms) which are dependencies and you must install it first. If the installer reports such dependencies, use the correct method for your operating system to find and install the dependencies, and then retry installation of the puppet agent.

**NOTE:** The puppet agent version should be greater than 3.0.0 and lower than 3.4.

- After you install the puppet agent, make sure that the puppet agent service is enabled to run on system start.
  - For Windows virtual machines, this must be done by viewing the services and setting the puppet agent service to "automatic".
  - For Linux virtual machines, verify whether the puppet agent is enabled by running the following command and checking the value of "enable" is set to true:

```
Puppet resource service puppet
```

Puppet resource service puppet

  - If the service is not set to true as noted above, run the following puppet command as administrator:

```
puppet resource service puppet enable=true
```

- Time must be synchronized between the ASM appliance and the virtual machine being cloned to ensure proper check-in upon completion of cloning. Make sure that NTP is configured on the virtual machine. Follow the appropriate instructions for your operating system to synchronize the virtual machine with an NTP server.

- Make sure the ASM appliance hostname "dellasm" can be resolved by using DNS. Either add the appropriate CNAME record in DNS* or add the appropriate host entries to "/etc/hosts" in Linux or "C:\windows\system32\driver\etc\hosts" in Windows.

- Configure the puppet.conf file to use "dellasm" as a server. To configure the puppet.conf file, perform the following:

```
puppet config print config
```

  - Open the puppet.conf file by using a text editor and add the line "server = dellasm" to the [main],[master], and [agent] section. If any of these sections does not exist, create them. A sample resulting puppet.conf file may look similar to the following:

```
[main]
server=dellasm
[master]
server=dellasm
[agent]
server=dellasm
```

**NOTE:** Extra lines may be present in the puppet.conf file for your system. It is not necessary to delete any information from this file. You need to ensure that the previously noted section is present in the file.

### Customizing Linux Template

Perform the following steps to customize a Linux template:

- Ensure that you have completed the following instructions for VMware or Hyper-V virtual machines: For more information about customization instructions, see the "Customizing Virtual Machine Templates or Virtual Machines for VMware or Hyper-V" section in this document.
  - Install the VMware tools—VMware only.
  - Install puppet agent and ensure that it is configured to run on startup.
  - Ensure that ASM Appliance and virtual machine time are synchronized by NTP.
  - Ensure that DNS is configured for dellasm to resolve. It must resolve to the ASM IP address.
  - Ensure that the puppet.conf file is updated with configuration to point to dellasm as server. For example,

```
[main]
servers = dellasm
logdir = /var/log/puppet
rundir = /var/run/puppet
```

---

**Dell**

21
ssldir = $vardir/ssl

[agent]
classfile = $vardir/classes.txt
localconfig = $vardir/localconfig

1. Copy the puppet_certname.sh and puppet_certname.rb from the /opt/asm-deployer/scripts directory on the ASM Appliance to the /usr/local/bin on the source Linux virtual machine.

   ⚠️ NOTE: Ensure that the version of the inifile gem installed by the puppet_certname script is specified as 2.0.2. To verify the version, open the puppet_certname.sh file and check that the inifile version is specified as 2.0.2.

2. Run the following commands to ensure that correct permissions are set on the scripts:
   
   ```
   chmod 755 /usr/local/bin/puppet_certname.sh
   chmod 755 /usr/local/bin/puppet_certname.rb
   ```

3. Download the ruby gem files inifile, 2.0.2 version, and hashie (latest version compatible with the operating system) from https://rubygems.org/ and place them in /usr/local/bin directory where you copied the puppet certname scripts. The gem installation process retrieves the local gem files in the current working directory of the script to install them.

4. Alternatively, these gems can be preinstalled on the source virtual machine. If you want to preinstall the required gems, modify the puppet_certname.sh after installing them. Remove the following lines including indentations from the puppet_certname.sh script:
   
   ```
   #!/bin/bash
   VERSION=`puppet --version`
   if [[ "$VERSION" =~ Enterprise ]];
   then
       /opt/puppet/bin/ruby puppet_certname.rb
       /opt/puppet/bin/puppet agent -t
   else
       ruby /usr/local/bin/puppet_certname.rb
       puppet agent -t
   fi
   ```

5. Run the following commands to remove the rules that bind the MAC address of the network adapter to any specific interface and create the default network interface configuration:
   
   ```
   rm /etc/udev/rules.d/70-persistent-net.rules
   rm /lib/udev/rules.d/75-persistent-net-generator.rules
   ```

6. Run the following command to remove the current network configuration:
   
   ```
   rm /etc/sysconfig/network-scripts/ifcfg-<INTERFACE_NAME>
   ```

   ⚠️ NOTE: `<INTERFACE_NAME>` in the command must be replaced with the actual value for the network interface name. For RHEL/CentOS 6, these are typically eth0, eth1, eth2, and so on. For RHEL/CentOS 7, these may be ens192, ens32, eno16777736, and so on.

   ⚠️ NOTE: For RHEL 7, you must also change the network device naming scheme from the default configuration to the conventional format. The source virtual machine must generate names for network interfaces using eth# format (instead of ens### or eno#### format) - that is, the generated names for the devices should be eth0, eth1, eth2, and so on.

   First edit the /etc/default/grub file by adding this line—append the options if GRUB_CMDLINE_LINUX variable already exists in the file:

   ```
   GRUB_CMDLINE_LINUX="net.ifnames=0 biosdevname=0"
   ```

   After editing the file, reconfigure the Boot configuration by running the following command:

   ```
   grub2-mkconfig -o /boot/grub2/grub.cfg
   ```

   ⚠️ NOTE: You may skip this step if the source virtual machine does not have these rules.
7. Create `/etc/sysconfig/network-scripts/ifcfg-eth0` with the following content:
   
   ```
   BOOTPROTO=dhcp
   ONBOOT=yes
   HOTPLUG=yes
   DEVICE=eth0
   TYPE=Ethernet
   PEERDNS=no
   NM_CONTROLLED=no
   ```
   
   Create `/etc/sysconfig/network` with the following content:
   
   ```
   NETWORKING=yes
   NETWORKING_IPV6=no
   ```

8. Configure a cron job that executes the `puppet_certname.sh` script and restarts the puppet service in reboot events.

   Type the following command to open the crontab editor:
   
   ```
crontab -e
   ```

   Type the following commands in the crontab editor:
   
   ```
   For RHEL/CentOS 6:
   @reboot sleep 60; /usr/local/bin/puppet_certname.sh > /var/log/puppet_certname.log 2<&1; /etc/init.d/puppet restart
   
   For RHEL/CentOS 7:
   @reboot sleep 60; /usr/local/bin/puppet_certname.sh > /var/log/puppet_certname.log 2<&1
   ```

   Run the following command to verify that the crontab is updated:
   
   ```
crontab -l
   ```

   **NOTE:** The log file, `/var/log/puppet_certname.log`, shows the output of the `puppet_certname.sh` script, which helps troubleshooting process.

9. After completing the customization, turn off the virtual machine.

10. Remove the virtual network adapter from the source virtual machine through the vSphere or the Hyper-V manager. Optionally, the virtual machine may be converted into a virtual machine template at this point. For example, right click virtual machine in the vSphere Client and click `Template → Convert to Template`.

    **NOTE:** Do not turn on the virtual machine after creating the template or the Linux virtual machine. If you turn on the virtual machine, ensure that you clean up the machine before you use it as a source machine. To clean up the virtual machine:

    a. Delete the puppet verification file from the system. The file is available at `/var/lib/puppet/verification_run.txt`. Optionally, the log file at `/var/log/puppet_certname.log`, may also be deleted.
    
    b. Delete the content under the following directories—— `/var/lib/puppet/ssl`, `/var/lib/puppet/client_data`, `/var/lib/puppet/clientbucket`, `/var/lib/puppet/client_yaml`.
    
    c. Delete the `/var/lib/puppet/state` directory.
    
    d. Run the following command to clean up the puppet cert from the ASM server—replace `<CERTNAME>` with actual certname:

       ```
puppet cert clean <CERTNAME>
       ```
    
    e. Remove the certname entries from `puppet_conf` file to restore the `puppet.conf` file to its initial state.

---

**Customizing Windows Template**

Pre-requisites:

- Ensure that you have completed the following instructions for VMWare or Hyper-V virtual machines: For more information about customization instructions, see Customizing Virtual Machine Templates or Virtual Machines for the VMware or Hyper-V topic in this document.
Installing the VMware tools—VMware only.
Installing the puppet agent and ensure that it is configured to run on startup.

* You can install the puppet agent by accessing the agent on the ASM Appliance using the CIFS connection on the guest operating system or from the \dellasm\razor folder in the local system.

NOTE: It is recommended that you install the puppet agent version 3.6.2.

* Run the puppet-3.6.2.msi file on the system with the guest operating system using an administrator access.

Ensure that the ASM Appliance and virtual machine time are synchronized by NTP.

Ensure that the DNS is configured for dellassm to resolve.

* Update hosts file on the system with the guest operating system to ensure that the guest operating system is able to resolve ASM Appliance host name dellassm.

NOTE: The hosts file is at C:\Windows\System32\drivers\etc.

* To edit the hosts the file, perform the following steps:
  a. Open Notepad using the Start menu.
  b. Right-click and click Run as administrator.
  c. Click File → Open.
  d. Navigate to the location of the hosts file and open the file.
  e. Add the following to the hosts file:
     <Your ASM IPs> dellassm # Dell ASM virtual appliance
  f. Ensure that the puppet.conf file is updated configuration to point to dellassm as server.
     [main]
     server=dellasm
     [master]
     server=dellasm
     [agent]
     server=dellasm

NOTE: The puppet.conf file is available at C:\ProgramData\PuppetLabs.

1. Navigate to the /opt/asm-deployer/scripts folder on your ASM Appliance and copy the following files or scripts to the root folder on the C: drive on the system with the guest operating system:
   - puppet_certname.bat
   - puppet_certname.rb

NOTE: On a systems running Windows operating system, you can access these files using ssh or the WinSCP client.
You can also use the following command to copy the files: $sudo cp puppet_certname.bat puppet_certname.rb /var/lib/razor/repo-store
   This command moves the files to the \dellasm\razor folder. Then you can access the files using CIFS from the system with the guest operating system.
   - Copy the files to the root folder on the C: drive on the system with the guest operating system.

2. Download the latest version of the following files from https://rubygems.org to the root folder:
   - hashie-3.4.6.gem
   - infiile-3.0.0.gem

3. Launch Windows Task Scheduler, and create a task. On the General tab,
   a. Type the Name in the Name field.
   b. Select the Run whether user is logged on or not option.
   c. Select the Run with highest privileges option.
   d. Select the operating system name from the Configure for drop-down menu.

   NOTE: Ensure that the operating system you select aligns with the guest operating system you are preparing.

4. Click the Triggers tab.
a. Create the **New** trigger.
b. Select the **At startup** option from the **Begin the task** drop-down menu.
c. Select **Enabled** under the **Advanced Settings** section.
d. Click **OK**.

5. Click the **Actions** tab.
a. Create **New Action**.
b. Select **Start a program** from the **Action** drop-down menu.
c. Click **Browse** to navigate to the C: drive and select the *puppet_certname.bat* script.
d. In the **Start in (optional)** field, type C:\
e. Click **OK**.

6. Click the **Conditions** tab.
a. Ensure that following options under the **Power** section are selected:
   - Start the task only if the computer is on AC power.
   - Stop if the computer switches to battery power

7. Click the **Settings** tab.
a. Ensure that following options are selected:
   - Allow task to be run on demand
   - Stop the task if it runs longer than:
   - If the running task does not end when requested, force it to stop
b. From the **If the tasks are already running, then the following rule applies** drop-down menu, select **Stop the existing instance**:
c. Click **OK**.

You are prompted for a password.

8. After completing the customization, turn off the virtual machine. To create a virtual machine template, follow the appropriate steps for your virtualization environment now.

   **NOTE:** To create a virtual machine template in SCVMM, ensure the virtual machine template **OS Configuration** has an administrator password and if necessary, a Windows product key set. To do this, right-click the virtual machine template and select "Properties", then select "OS Configuration" and enter a password in **Admin Password** and a product key in the **Product Key settings**.

   **NOTE:** After preparing the base virtual machine, in case the virtual machine is restarted, do the following:
   - Delete the puppet verification file from the system. This file can be found in Windows at C:\ProgramData\puppet\verification_run.txt or in Linux at `/var/lib/puppet/verification_run.txt`
   - Delete the ssl directory at `/var/lib/puppet/ssl` for Linux VMs and C:\ProgramData\PuppetLabs\puppet\etc\ssl for Windows VM.
   - Remove the certname entry from *puppet_conf* file.

   **NOTE:** HyperV - Ensure that the VM template is not created using the Microsoft System Preparation Tool (sysprep) to avoid any failure during unattended operating system installation.

9. Click **Run Inventory** in **ASM Resources** UI page on the SCVMM instance to ensure that up-to-date information is available in **ASM**.

10. After you deploy the template, you can test the guest operating system by running the following command:

    > puppet agent -t

**Customizing the vCenter Windows Template**

   **NOTE:** Ensure that you have met the pre-requisites before you begin customizing the template.

1. Install the VMware tools on the guest operating system.
2. Install the puppet agent and ensure that you configure the puppet agent to run at startup.
You can install the puppet agent by accessing the agent on the ASM Appliance using the CIFS connection on the guest operating system or at the following path in the local system: `\dellasm\razor`.

Move the puppet agent directory to a default location on the system with the guest operating system.

**NOTE:** It is recommended that you install the puppet agent version 3.6.2.

3. Run the agent 3.2.1 .msi file on the system with the guest operating system. Perform this step using an administrator access.

4. Ensure that the ASM Appliance and virtual machine time are synchronized using the Network Time Protocol (NTP).

5. Ensure that DNS is configured for `dellasm` to resolve. Creating an entry in DNS with forward and lookup pointers enables you to pull and resource your ASM Appliance instance.

6. Ensure that the file on the system with the guest operating puppet.conf system is updated to include `dellasm` as the server for each of the entries.

7. Open the puppet.conf file in a text editor with Administrator privileges and include the following:
   ```
   [main]
   server=dellasm
   [master]
   server=dellasm
   [agent]
   server=dellasm
   ```

   **NOTE:** The puppet.conf file is available at the following location on the system with the guest operating system that you preparing: `C:\ProgramData\PuppetLabs\puppet\etc`.

8. Update hosts file on the system with the guest operating system to ensure that the guest operating system is able to resolve ASM Appliance host name. `dellasm`.

   **NOTE:** The hosts file is at `C:\Windows\System32\drivers\etc`.

   To edit the file, perform the following steps:

   a. Open Notepad using the Start menu.
   b. Right-click and click Run as administrator.
   c. Click File → Open.
   d. Navigate to the location of the etc hosts file and open the file.
   e. Add the following to the hosts file: `<Your ASM IP> dellASM Dell ASM Virtual Appliance`

9. Navigate to the `/opt/asm-deployer/scripts` folder on your ASM Appliance and move the following files or scripts to `/var/lib/razor/repo-store` location on the system with the guest operating system:
   - Puppet_certname.bat
   - Puppet_certname.rb

   **NOTE:** On a systems running Windows operating system, you can access these files using ssh or WinSCP client.

   You can also use the following command to move the files: `$sudo mv puppet_certname.bat puppet_certname.rb /var/lib/razor/repo-store`

   This command moves the files to the `\dellasm\razor` folder. You can access the files using CIFS from the system with the guest operating system.

10. Move the files to the C: drive on the system with your guest operating system.

11. Download the latest version of the following files from [https://rubygems.org](https://rubygems.org) to the C: drive on your guest operating system.
   - hashie
   - inifile
Enabling EMC VNX Support

ASM uses Navicli to perform operations on EMC VNX. For discovery and deployments that involve VNX, the ASM Appliance must be installed with Navicli. You must install the Navicli tool manually, because the tool is available only to licensed Customers of EMC VNX.

To install Navicli:

1. Download the Navicli Tool.
   a. To download the supported RPM version, go to Support.emc.com.
   b. Navigate to Downloads → Downloads for VNX/VNXe Family → Recommended → Navisphere CLI 7.33.8.1.19.
2. Copy the downloaded rpm (that is NaviCLI-Linux-64-x86-en_US-7.33.8.1.19-1.x86_64.rpm) to home directory of the ASM Appliance.
3. To install the RPM, run the following command:
   
rpm -ivh NaviCLI-Linux-64-x86-en_US-7.33.8.1.19-1.x86_64.rpm

   If you want to change the execution mode, run the following command:
   
   chmod 755 NaviCLI-Linux-64-x86-en_US-7.33.8.1.19-1.x86_64.rpm

Installing Plug-ins for EMC to Support Volume Provisioning

To support volume provisioning on a EMC VNX 5300 and VNX 5400 storage array, ensure that you install the plug-ins on a storage array.

To install the Software Enabler feature:

1. Start Unisphere Service Manager (USM).
2. Log in to the storage array.
3. Copy the enabler (.ena file) to the c:\emc\repository\Downloads\VNX folder on the windows host where you installed USM. Create the folder in case the folder does not exist. The file is available on the disks that shipped with your storage array.
4. In the System window, click Software → System Software → Prepare for Installation.
5. Click Software → System Software → Install Software to proceed with the installation.
6. Select Install VNX OE for block and/or enablers option and follow the instructions on the screen.
   The controllers reboot after the feature is installed. This process may take up to 45 minutes for each Service Processor (SP).
7. When the installation is complete, click Finish.

Perform the following steps to verify if the feature is installed:

1. Log in to EMC Unisphere.
2. Click All System → System List.
3. Right-click the storage array and select Properties.
4. Click the Software tab.
   A list of enabled features is displayed.

   NOTE: Ensure that Thin Provisioning is listed under Packages. If not, follow the steps to add the feature.
Completing Initial Configuration

Log in to ASM using the appliance IP address. After logging in to ASM, you must complete the basic configuration setup in the Initial Setup wizard. After that you get four other wizards that allow you to define Networks, discover resources, configure resources, and publish template. For more information, see the Active System Manager Release 8.3.1 User's Guide.

**NOTE:** If you use the ASM 8.3.1 user interface, to log in you must use the user name as **admin** with the default password as **admin**.
Installing Windows ADK 8.1 for OS Prep for Windows

You must perform the following configuration tasks before using ASM to deploy Windows OS:

**NOTE:** You should use Microsoft ADK 8.1 installed in the default location. Ensure to install all options during ADK installation process.

1. Create a Windows .iso that has been customized for use with ASM using ADK and build-razor-winpe.ps1 script. You must locate the appropriate drivers for your server hardware or virtual machines for the operating system you are trying to install. For Dell hardware, drivers can be obtained from support.dell.com. For other vendors such as VMware, follow the instructions from the manufacturer to locate the correct drivers. During .iso customization it is updated to include the drivers required for VMware virtual machine VMXnet3 NiCs, any other drivers specific to your hardware, and customizations for use with ASM. This allows you to support operating system deployment through ASM of Windows 2008 R2, Windows 2012, or Windows 2012 R2 to virtual machines or bare-metal servers. For more information see, Creating WinPE Image and Updating Install Media for Windows 2008 R2, Windows 2012, and Windows 2012 R2

2. Create a Windows repository and copy Windows installation media (customized Windows .iso from step 1) on ASM Appliance. Ensure that the build directory has space available for the working build files, and the final .iso file that is created. It is recommended to have enough space available for approximately three times the size of the .iso file. For more information, see Adding OS Image Repositories

**NOTE:** Approximately four times the .iso size space (approximately 25 GB) is required to perform .iso processing on the ADK machine.


You should have Windows Assessment and Deployment toolkit that contains the Windows PE environment used to automate the Windows installer installed in the DEFAULT location on a Windows machine. Licensing for Windows PE requires that you build your own customized WinPE WIM image containing the required scripts.

To create customized Windows.iso image for Windows 2008 R2, Windows 2012, and Windows 2012 R2:

1. Create a build folder on your ADK machine. For example, ADK machine build directory may be “c:\buildpe”.
2. Within this build folder create a directory called “Drivers”.

---

Adding OS Image Repositories

NOTE: Approximately four times the .iso size space (approximately 25 GB) is required to perform .iso processing on the ADK machine.
NOTE:

• If any additional drivers are required, add the drivers under the “Drivers” folder in the build directory you created on your ADK machine. The drivers are installed into the Windows image, if applicable. The drivers that do not apply to the OS being processed are ignored.

• If you want to deploy Windows to VMware VMs, the WinPE drivers for the VMXNET3 virtual network adapter from VMware required. To obtain the VMware Windows drivers: Install VMware tools on a running Windows 2012 or Windows 2012 R2 and on the virtual machine. Go to the `C:\Program Files\Common Files\VMware\Drivers` directory. Copy the contents in the Drivers folder to the directory that contains your WinPE build scripts.

• If you deploy Windows 2012 or 2012 R2 to an M420 server, drivers for Broadcom network adapters must be added to the image, as they are not included in Windows. Obtain a copy of the Broadcom or QLogic Drivers for an M420 server from dell.com and install the driver package on a Windows 2012 or 2012 R2 machine. Locate the Windows drivers on the files system and copy them to the “Drivers” folder. These drivers typically start with "b57".

• Native driver support for Dell server components in Windows 2008 R2 is limited, so obtain the latest NIC and RAID drivers for Windows 2008 R2 from Dell.com.

3. Log in to the ASM virtual appliance and obtain the script “build-razor-winpe.ps1” from the `/opt/razor-server/build-winpe` directory and copy this to the build directory created in step 1 on your machine with ADK 6.3 or 8.3 installed in the default location.

4. The build-razor-winpe script supports an ASM appliance that uses an external DHCP/PXE server, or using the ASM appliance as your DHCP PXE server. This command to run this script has the following structure:

```
powershell -executionpolicy bypass -file build-razor-winpe.ps1 [ASM appliance IP or “DHCP”] [Your Windows .iso name] [New Windows .iso name]
```

If ASM does not act as the DHCP/PXE server, that is your DHCP/PXE server is external, you run the script and provide the ASM appliance IP as input.

For example,

```
powershell -executionpolicy bypass -file build-razor-winpe.ps1
192.168.2Windows2012r2.iso ASMWindows2012r2.iso
```

If ASM acts as the DHCP/PXE server you run the script and provide the input “DHCP” instead of the ASM appliance IP.

For example:

```
powershell -executionpolicy bypass -file build-razor-winpe.ps1 DHCP Windows2012r2.iso
ASMWindows2012r2.iso
```

NOTE: This step takes some time to complete. After completion, it creates a Windows .iso file which is customized for using with ASM. You must go to repositories and upload .iso file.

NOTE: If the build script fails or is stopped during execution, it may be necessary to clean up files in the build directory before running again. Sometimes, directories may still be mounted and require cleanup. To clean up, delete all files other than the necessary script, starting .iso, and Drivers folder. If any files cannot be deleted, try running the following commands from a command prompt in the build folder location:

```
C:\buildpe>dism /cleanup-wim
```

Adding OS Image Repositories

You can add one or more OS image repositories in ASM GUI.

To add an OS image repository, perform the following tasks in the ASM GUI:

1. On the home page, click Settings → Repositories.
2. On the Repositories page, click OS Image Repositories tab, and then click Add.
3. In the Add OS Image Repository dialog box, perform the following actions:
   a. In the Repository Name box, type the name of the repository.
   b. From the Image Type drop-down menu, select the appropriate image type.
c. In the **Source File** or **Path Name** box, type the path of the OS Image file name in a file share.

d. If using a CIFS share, type the User Name and Password to access the share. These fields are only enabled when entering a CIFS share.

For more information about firmware repositories, see *ASM Online Help*. 
Configuring DHCP or PXE on External Servers

The PXE service requires a DHCP server configured to provide boot server (TFTP PXE server) information and specific start-up file information. ASM PXE implementation uses the iPXE specification so that the configuration details include instructions to allow legacy PXE servers and resources to boot properly to this iPXE implementation.

This section provides information about configuring DHCP on the following servers. The information includes only the basic configuration options and declarations required for an iPXE environment. These details should be used as a cumulative addition to the settings currently used in your DHCP implementation (if you already have a DHCP environment).

- Microsoft Windows 2012 Server. See Configure DHCP on Windows 2012 DHCP Server
- Microsoft Windows 2008 Server R2. See Configure DHCP on Windows 2008 DHCP Server
- Linux DHCPd (ISC DHCP). See Configuring DHCP for Linux

NOTE: Ensure that your DHCP scope has enough IP addresses. The installation process can temporarily consume between 4-8 IPs during the initial PXE boot process. This is based on interface card configuration and the number of physical interfaces on the server. These IPs only used temporarily during server configuration and installation.

Configure DHCP on Windows 2012 DHCP Server

To configure the DHCP on Windows 2012 DHCP Server, perform the following tasks:

1. Create DHCP User Class
2. Create DHCP Policy
3. Create Boot File scope option

For additional information, see http://ipxe.org/howto/msdhcp

Creating the DHCP User Class

You must create the user class for the DHCP server before creating the DHCP Policy.

1. Open the Windows 2012 DHCP Server DHCP Manager.
2. In the console tree, navigate to IPv4. Right-click IPv4, and then click Define User Classes from the drop-down menu.
3. In the DHCP User Classes dialog box, click Add.
4. In the New Class dialog box, type the following information and click OK to create a user class.
   a. In the Display Name box, type iPXE.
   b. In the Description box, enter iPXE Clients.
   c. In the data pane, under ASCII, enter iPXE.
5. Click Close.

Creating the DHCP Policy

1. Open the Windows 2012 DHCP Server DHCP Manager.
2. In the console tree, expand the scope that services your ASM OS Installation network. Right-click Policies and select New Policy.
The DHCP Policy Configuration Wizard is displayed.

3. Next to Policy Name, type iPXE and enter the description as iPXE Client. Click Next.

4. On the Configure Conditions for the policy page, click Add.

5. In the Add/Edit Condition dialog box, perform the following actions, and then click OK.
   - Select User Class from the Criteria list.
   - Select iPXE from the list of Values and click Add.

6. On the Configure Conditions for the policy page, select the AND operator and click Next.

7. On the Configure settings for the policy page, select the AND operator and click Next.
   - If you want to use only the portion of the DHCP scope for PXE, click Yes, and then enter the IP address range to limit the policy.
   - If you do not want to use the portion of the DHCP scope for PXE, click No.

8. For PXE service to function properly, under Available Options, select 067 Bootfile Name, and enter the string value as bootstrap.ipxe.

9. Click Next, and then click Finish.

Creating the Boot File Scope Option

1. Open the Windows 2012 DHCP Server DHCP Manager.

2. In the console tree, expand the scope that services your ASM OS Installation network. Right-click Scope Options and select Configure Options.

3. In the right pane, enter the following information:
   - Click 066 Boot Server Host Name and enter the IP address or DNS name of ASM server in the Value column.
   - For PXE service to function properly, click 067 Bootfile Name and enter undionly.kpxe in the Value column.

4. In the right pane, configure the following based on your network settings:
   - 003 Router (default gateway that is on the OS Installation network)
   - 006 Name Server (DNS server IP address)

Configuring DHCP on Windows 2008 DHCP Server

To configure the DHCP on Windows 2008 DHCP Server, perform the following tasks:

1. Create DHCP User Class
2. Create DHCP Policy
3. Create Boot File Scope Option

For additional information, see http://ipxe.org/howto/msdhcp

Creating the DHCP User Class

You must create the user class for the DHCP server before creating the DHCP Policy.

1. Open the Windows 2008 DHCP Server DHCP manager.

2. In the console tree, navigate to IPv4. Right-click IPv4, and then click Define User Classes from the drop-down menu.

3. In the DHCP User Class dialog box, click Add to create a user class.

4. In the New Class dialog box, enter the following information and click OK to create a user class.
   a. In the Display Name box, enter iPXE.

      NOTE: The binary for the output of the ASCII “iPXE” is (69 50 58 45).

   b. In the Description box, enter iPXE Clients.

   c. In the data pane, under ASCII, enter iPXE.

5. Click Close.
Creating the DHCP Policy

Use the new User Class to create a DHCP policy scope option.

1. Open the Windows 2008 DHCP Server DHCP manager.
2. Add a scope option to the DHCP scope that services ASM PXE environment.
3. In the Scope Options dialog box, click the Advanced tab, select the 067 Bootfile Name check box, and in the String value box, enter bootstrap.ipxe.

   NOTE: For PXE service to function properly, you must enter bootstrap.ipxe for the 067 Bootfile Name.

4. Select DHCP Standard Options from the Vendor class drop-down list.
5. Select iPXEclass from the User Class drop-down list.
6. Click OK to save the scope option.

The policy is created by utilizing the new User Class with a scope option.

Creating the Boot File Scope Option

The Boot File option is created for the DHCP scope that services your ASM PXE.

1. Open the Windows 2008 DHCP Server DHCP Manager.
2. In the console tree, expand the scope that services your ASM PXE network. Right-click Scope Options and select Configure Options.
3. In the right pane, enter the following information:
   - Click 066 Boot Server Host Name and enter the IP address or DNS name of ASM server in the Value column.
   - For PXE service to function properly, click 067 Bootfile Name and enter undionly.kpxe in the Value column.
4. Also, in the right pane, based on your network settings, configure the following:
   - 003 Router (default gateway that is on the PXE network)
   - 006 Name Server (DNS server IP address)

Configuring DHCP for Linux

You can manage the configuration of the Linux DHCPD service by editing the dhcpd.conf configuration file. The dhcpd.conf is at /etc/dhcp directory of most Linux distributions. If the DHCP is not installed on your Linux server, install the Network Infrastructure Server or similar services.

Before you start editing the dhcpd.conf file, it is recommended to back up the file. After you install the appropriate network services, you must configure the dhcpd.conf file before you start the DHCPD service.

The DHCP configuration must include the following options:

- **next-server <IP address>**
  Indicates the IP address of the PXE server. That is, the IP address of ASM appliance vNIC that exists on the OS Installation network.

- **filename "bootstrap.ipxe"**

  NOTE: For PXE service to function properly, you must specify bootstrap.ipxe for the filename.

The PXE service uses iPXE service. You must use two different bootstrap files for the PXE environment, one for the initial PXE boot, which starts up the system to the final iPXE boot file.

To run this operation, add the following code to the dhcpd.conf file:

```bash
if exists user-class and option user-class = "iPXE" {
    filename "bootstrap.ipxe";
} else {
```
Secondly, add the following code to the subnet declaration within your `dhcpd.conf` file. This code instructs a legacy PXE server to boot to a legacy boot file, and then directs to the iPXE boot file. For more information, see the Sample DHCP Configuration.

The configuration file must contain the following information:

```bash
# dhcpd.conf
# Sample configuration file for ISC dhcpd
default-lease-time 6000;
max-lease-time 7200;
authoritative;
log-facility local7;

subnet 192.168.123.0 netmask 255.255.255.0 {
    range 192.168.123.24 192.168.123.29;
    option subnet-mask 255.255.255.0;
    option routers 192.168.123.1;
    if exists user-class and option user-class = "iPXE" {
        filename "bootstrap.ipxe";
    } else {
        filename "undionly.kpxe";
    }
}
```

After you modify the `dhcpd.conf` file based on your environment, you need to start or restart your DHCPD service. For more information, see [http://ipxe.org/howto/dhcpd](http://ipxe.org/howto/dhcpd).

**Sample DHCP Configuration**

```bash
# dhcpd.conf
#
# Sample configuration file for ISC dhcpd
#
#option definitions common to all supported networks...
#option domain-name "example.org";
#option domain-name-servers 192.168.203.46;

#filename "pxelinux.0";
next-server 192.168.123.21;# IP address of ASM Server

default-lease-time 6000;
max-lease-time 7200;

# Use this to enables / disable dynamic dns updates globally.
#ddns-update-style none;

# If this DHCP server is the official DHCP server for the local
# network, the authoritative directive should be uncommented.
authoritative;

# Use this to send dhcp log messages to a different log file (you also
# have to hack syslog.conf to complete the redirection.
log-facility local7;

# No service will be given on this subnet, but declaring it helps the
# DHCP server to understand the network topology.
```
# This declaration allows BOOTP clients to get dynamic addresses, # which we don't really recommend.

# A slightly different configuration for an internal subnet.
# This is a very basic subnet declaration.

subnet 192.168.123.0 netmask 255.255.255.0 {
#}

subnet 192.168.123.0 netmask 255.255.255.0 {
range 192.168.123.24 192.168.123.29;
oreoption subnet-mask 255.255.255.0;
option routers 192.168.123.1;
if exists user-class and option user-class = "iPXE" {
    filename "bootstrap.ipxe";
} else {
    filename "undionly.kpxe";
}
}

# This declaration allows BOOTP clients to get dynamic addresses,
# which we don't really recommend.

subnet 10.254.239.32 netmask 255.255.255.224 {
#range dynamic-bootp 10.254.239.40 10.254.239.60;
#option broadcast-address 10.254.239.31;
#option routers rtr-239-32-1.example.org;
#}

# A slightly different configuration for an internal subnet.
subnet 10.5.5.0 netmask 255.255.255.224 {
#range 10.5.5.26 10.5.5.30;
#option domain-name-servers ns1.internal.example.org;
#option domain-name "internal.example.org";
#option routers 10.5.5.1;
#option broadcast-address 10.5.5.31;
#default-lease-time 600;
#max-lease-time 7200;
#}

# Hosts which require special configuration options can be listed in
# host statements. If no address is specified, the address will be
# allocated dynamically (if possible), but the host-specific information
# will still come from the host declaration.

host passacaglia {
# hardware ethernet 0:0:c0:5d:bd:95;
# filename "vmunix.passacaglia";
# server-name "toccata.fugue.com";
#}

# Fixed IP addresses can also be specified for hosts. These addresses
# should not also be listed as being available for dynamic assignment.
# Hosts for which fixed IP addresses have been specified can boot using
# BOOTP or DHCP. Hosts for which no fixed address is specified can only
# be booted with DHCP, unless there is an address range on the subnet
# to which a BOOTP client is connected which has the dynamic-bootp flag
# set.
host fantasia {
# hardware ethernet 08:00:07:26:c0:a5;
# fixed-address fantasia.fugue.com
#}
# You can declare a class of clients and then do address allocation based on that. The example below shows a case where all clients in a certain class get addresses on the 10.17.224/24 subnet, and all other clients get addresses on the 10.0.29/24 subnet.

#class "foo" {
#  match if substring (option vendor-class-identifier, 0, 4) = "SUNW";
#}

#shared-network 224-29 {
#subnet 10.17.224.0 netmask 255.255.255.0 {
#  option routers rtr-224.example.org;
# }
#subnet 10.0.29.0 netmask 255.255.255.0 {
#  option routers rtr-29.example.org;
# }
#  pool {
#    allow members of "foo";
#    range 10.17.224.10 10.17.224.250;
#  }
#  pool {
#    deny members of "foo";
#    range 10.0.29.10 10.0.29.230;
#  }
#}
